Continue

12331734.607143 34900929.45 18231771456 27429960.320513 11755571.125 10046871.551724 117644008160 41756309753 150359660470 7524200.5510204 139137581710 32402033 34241140362 8772728830 254350217.2 313936908 10899387913 10581492.431818 61436489450 15641991.284091 112069101.63636 14938125590
30263803.057692 22900150000 2661837.5405405 7843817.673913 76167741.904762 116919666567 100296152256 9298345.79 22021898.290323 6159949.5 163669677000

Cutting machine crafts pdf free printable patterns free

Easy Felt Monster Pencil Topper Want to get into the Halloween spirit? It does require a minimal amount of sewing but is a wonderful way of learning. Faux Leather French Bow This is an adorable faux leather bow tutorial that teaches you how to make layered French bows. In this post, I’m sharing 99+ easy and free Cricut projects for beginners.
DIY Happiness Jar Decal Would you like to remember all your happy times? And the best part is, you receive the SVG for FREE. 2. Go to Object > Ungroup to make each letter an individual path. This is an adorable way of creating vinyl sprinkles to apply onto pumpkin decor. Menu Planner Board I’m really loving this nifty way of using a meal planner.
Layered Greeting Cards Set This set of 24 greeting cards is an easy and fun way to get started with card making. 100. Unfortunately, it's possible that Inkscape may not be able to save a compatible file type for your machine. Current models include the Cricut Joy, Cricut Explore Air 2, and the Cricut Maker. Easter Bunny Jars Save this cute craft for
Easter. Paper Flower Wreath Tutorial I love a good floral wreath, and this is a perfect tutorial on how to make one by yourself. This is a great banner to use at their birthday party. If you have included text in your design, you'll have to convert the text to paths manually. This post will show you how to create one out of chipboard and is a fun toy for
your kids to play with. 25. Cricut Joy ($159) The Cricut Joy – is perfect for quick, everyday projects. Ensure that all objects have been converted to paths before proceeding if you're saving to DXF. Well here is another one for you. Select the text object (word) that you just wrote. Wonder Inspired T-shirt This t-shirt project is to show you how to apply
vinyl with a quote from the movie Wonder. 92. Custom Knock Out Text Pillow Have you tried to knock out text but couldn’t figure out how? Why not make these custom leather napkin rings to match your aesthetic. 63. Unicorn Birthday Banner Do you have a unicorn lover in your life? Here is a quick and easy tutorial on how to make a mermaid
pillow using vinyl. 48. Easy Holiday Gift Basket This is another plaid craft but when you use your own colours, you can create a gift basket to your liking. 71. These Oogie Boogie bags not only are easy to make but also is such a quick craft. 55. This tutorial provides the steps and SVG file to create your own unicorn-themed hair clips. 35.
Introductory video on the Cricut Maker Pin for later. Cupcake Holders This is such an adorable craft, perfect for little ones and adults as well. 72. Fiesta Cake Topper and Treat Bags Are you having a fiesta themed party? Saving into another format from Inkscape is a very straightforward procedure. This project also shows you how to make your own
gift bags. 77. Pretty Unicorn Crown By this time, you might be thinking, another unicorn craft? It is both great to wear and gift to someone else. If you select the Edit paths by the nodes tool and click on the text, you should be able to clearly see that the text has been combined. DIY Custom Foam Stamps This is a wonderful and fun way to create your
own custom foam stamps using your Cricut machine. These designs are great for coloring pages and coloring sheets, crochet patterns, drawing and painting, svg files for cricut and silhouette, svg cut files, hobbies, holiday crafts, iron-on designs, kid crafts, laser cutting, needlecrafts, preschool printables, quilting, sewing, scrapbooking, sign making,
string art (nail art), wall art, wedding crafts, woodworking projects, and other DIY arts and crafts. Mom Is On A Break Socks This funny craft will make you laugh as I did. What a creative and nifty idea for all those unicorn lovers. There's more information on that below. This tutorial not only shows you how to do so but also includes instructions on
how to create labels for them as well. 26. Cricut designs Patterns Letter Stencils Cricut Cutting Machines Personalize, organize, and customize your crafts and DIY projects with a Cricut cutting machine. Combine the letters will reduce the amount of cutting that most machines must do, however. First, select the text you converted to a path. The
best part is, that it does not require sewing! How great is that? 70. Adorable Felt Frog Craft Loving felt crafts? Custom Tooth Fairy Pouch Do you want to make your child’s first tooth memorable? Mason Jar Labels Are you looking to upcycle your mason jars? A great bonus is that most of these projects come with FREE SVG cut files that can be
downloaded by accessing the VIP library. In this list, you will find: Cricut projects with cardstock Cricut projects with vinyl Easy Cricut projects to sell Cricut cards And so much more… Let’s get started! Have a look at these free beginner Cricut Maker projects. 1. This post shows you a simple way to do so out of faux leather. Vinyl is a bit difficult to
work with but is definitely worth it! This is a beautiful way of customizing your tea towels. 17. I hope you enjoy creating them. Thanks for letting us know! Tell us why! Hi everyone! I’m Sumayyah from @CraftYourMemoriess on Instagram. Faux Leather Keychain This is another faux leather project that provides a cute addition on your keychain. 75.
Fabric Coasters This cute tutorial shows you how to make fabric coasters. If you have cutting machine software that can't open or import SVG files, you may be able to save an Inkscape file in another format which you can then import for use with your machine. Here is an awesome and cute way to do so. 39. What can I say? 3D Layered Owl Mandala
Are you into the mandala trend but also want one fall-related? These 5-minute coasters will remind you of your summer all year round. 53. Use the Text Tool to write out a word to work with. Unicorn Hair Clips Still loving the unicorn crafts? 5 Minute Summer Coasters Here is another quick, easy, and nifty craft. Oogie Boogie Treat Bags Have a small
Halloween party coming up? I Love You Gift Tag This gift tag can not only be used on Valentine’s Day but also on anniversary’s and other occasions where you would like to express your love to someone special. 97. Felt Shark Craft This cute craft is great for kids once the finished product is made. More FREE patterns and lettering fonts. This post is
a collection of a lot of fun and easy projects and includes crafts for the Cricut Explore Air family, Cricut Maker, and the Cricut Joy. You should see a bounding box around each letter that indicates that they're all selected. Giant Paper Flower Tutorial If you stayed till the end, thanks for checking out all these amazing and easy Cricut projects. Then
click and drag a marquee that completely encompasses all the text. Click on the links below to find cutting files (SVG Files) for your Cricut cutting machine. Easy Totoro Template This post shows you how to create and sew a Totoro plush for your child. Custom Vinyl Labels Are you new at vinyl? Here is a great one that is perfect for the fall. 60. This
is great for so many occasions, including birthdays, baby showers, and more. It is never too early to start. Cricut Cutting Designs (SVG Files) Use your Cricut to create paper crafts, cards, DIY projects, scrapbooking, etc. The best part is you can make it with inexpensive materials! 5. DIY Fall Burlap Wreaths This tutorial is perfect for the Fall and
Halloween season! It comes with free printables as well. 38. Mother’s Day Card Do you want to create an easy Mother’s Day card you know your mom will cherish and love? Here is another creative way to make Halloween more fun (and slightly educational) for your kids. 13. You can use the same idea in this post to customize your own pieces of
furniture. 7. Paper Pansy Tutorial Do you want to learn how to make different types of flowers? This project shows you how to make a custom cake topper and treat bags to suit your theme. 95. Why not try this cute and funny card tutorial. To choose another format, go to File > Save As after it's saved to open the Save dialog, click on the Type dropdown list, and select the file type you want to save to; your choice will depend upon your cutting machine software. Print Then Cut Straws This is a great way of adding some flair to your straws using the Print then Cut method. 65. These cutting machines use vector line files for their templates, and there are a number of different types. Just cut the
pieces out with your Cricut machine and then it can be assembled by your kids. Use a Cricut cutting machine to quickly and accurately cut out patterns and designs on your favorite material. Well I’ll keep them coming. This post is a great way to do so. 36. Welcome to Cut N Make Crafts. Vinyl Coffee Mug Here is another Christmas related tutorial
but can also be used for many different occasions. Once you learn this skill, you’ll never go back! This post also shows you how to turn a photo into a decal with another software called Inkscape. 14. This owl mandala is such a beautiful piece to add to your home decor. 33. Butterfly Pop-up Card This cute butterfly pop-up card is a creative way of
trying pop-ups for the first time! 96. A cutting machine reads vector line file paths and translates them into cuts in the paper. 54. As with most technology, cutting machines have become more and more affordable as time goes by. Custom Magnet Tutorial Want to make some cute and custom magnets? Cricut Explore Air 2 ($227) The Cricut Explore –
can cut a wide range of craft materials with precision. Fortunately, some options make it possible for enthusiasts to produce their own template designs for cutting machines. Matching Mommy And Me Bear Cups These cute matching “mommy and me” cups are adorable and great to make. 67. Mini Canvas Banner Are you into canvas banners? Felt
Floral Wreath Here is another floral wreath but this time made out of felt. This is the most popular Cricut machine sold. Disney Parks Snack T-shirt This easy project gave me a quick laugh. 59. I hope you enjoy creating them. 20. Custom Iron-on T-Shirt This is an easy tutorial that teaches you how to apply iron-on vinyl to a shirt. See Cricut for
Beginners for more crafting ideas. This post gives you step by step instructions on how to create a Fall door mat using stencils. 45. Cricut Maker ($369) The Cricut Maker – is the ultimate smart cutting machine. Pattern Uses and Types of Materials You can use these patterns, stencils, templates, models, and shapes as a guide to make other objects or

to transfer designs. When downloading a pattern or stencil, you can specify a new color (e.g., red, orange, yellow, green, blue, purple, brown, magenta, tan, cyan, olive, maroon, navy, aquamarine, turquoise, silver, lime, teal, indigo, violet, pink, black, white, gray, or grey). DIY Easter Bunny Garland Here is another Easter craft but is a garland this
time. Felt Superhero Masks I’m really liking these two minute felt superhero masks that are so simple to make. 86. This project takes about 5 minutes once cut which is perfect for a quick beginner Cricut project. 3. Intricate Graduation Card This post provides you with a FREE SVG template to quickly make this beautiful card. Awesome Football TShirt Are you into football? Layered Home Sweet Home Mandala Tutorial Have you seen the latest trend of creating layered mandalas? Be sure to check your machine's software documentation to see whether it can accept any of the file types that Inkscape produces. This is a full-on tutorial on how to do so and even make it 3D! This cake topper post
can also be altered to fit your own design. 19. Sometimes as a newbie in the Cricut world, you may find tutorials with varying levels of difficulty. This compact, portable cutting machine makes it easy to create labels, monograms, and thousands of other designs in cardstock, vinyl, and paper. Felt Unicorn Sleep Mask Do you have trouble sleeping with
the light open or during the daytime? You will need a sewing machine, but it is adorable, and definitely a keeper. 27. Thanksgiving Favour Boxes This Thanksgiving-related favor box is perfect for filling up with goodies. 62. This is very easy, and it only takes a few seconds. 31. Not only is it ‘punny’ but also romantic! 23. Faux Leather Earrings Ever
thought of creating your own earrings? Custom Cosmetic Bag This cute sewing project gives you the method on how to create a custom cosmetic bag with your Cricut machine. Felt Christmas banner Here is another Christmas-related decor piece but you can customize the colours for your own occasion. 51. Some common file formats that can be
imported and converted are DXF, EPS, and PDF files. By using your own image, you can make your own custom pillow. Teacher’s Tumbler Gift This is a cute end of the school year gift to give to your child’s teacher to appreciate their hard work. 82. Paper Popsicle Garland This super cute garland is perfect to use as decor for a summer party or even
a cute craft for kids. 61. These formats can make it difficult for users to easily produce files for use with different machines. 64. Halloween Monster Bookmark With Halloween around the corner, this easy bookmark making tutorial is a fun way to get your kids involved and encourage reading at the same time. 11. It does take a bit of time but once
you mastered some of the skills from the above links, this will be a cakewalk. 21. Go to Path > Object to Path. Not only can you customize the colour of the card, but the wedded couple will know you made it with love. 73. This post gives you tips and tricks on how to do it and the best part is that you can apply this method to the text of your choice!
57. Every time you have a happy moment, write it on a small piece of paper and put it in this jar to store for a lifetime. 98. This is a great way to do so. Turtle Paper Craft Here is another kid-friendly craft, but this time using paper! This super cute turtle craft is a fun way to create a quick activity for your child. 29. All you need is the SVG file
provided and you can add this beautiful piece of decor to your home. 32. Geometric Heart T-Shirt Last but definitely not least, this geometric heart t-shirt. DIY Unicorn Bookmark I love bookmarks but sometimes it’s nice to DIY your own! This unicorn-themed bookmark is such a creative and easy way of doing so. 16. This tutorial is great to show
beginners how to do so. 52. Buffalo Plaid Reindeer Pillow Looking for a quick and easy craft? Create personalized, custom projects for your home, for craft shows, for selling projects online, etc. Well here is an easy project for you. It also comes with a free SVG file. 94. Finally, export your object to the type of format that you can work with. You will
need a Cricut Maker for this Cricut Maker project. 80. Custom Tea Towels Let’s get into some vinyl projects, shall we? 3D Giant Paper Snowflake I am really loving this 3D giant paper snowflake craft! Its is perfect to hang up and use as winter decor. 44. This craft takes approximately 15 minutes. 43. Felt Cloud Wall Hanging I’m loving this cute felt
cloud craft that is perfect for decor in your baby’s nursery. Looking for More Patterns, Stencils, Designs? You can easily apply vinyl to a mug with this post. 42. Pop-up Mother’s Day Card Here is another great and easy card that can be used for Mother’s Day. Fall Door Mat Want to create some home decor to put outside? Custom magnets This post
shows you how to customize magnets for a chore chart. It takes minimal resources to make such a gorgeous card that others will be asking you to create some for them. This is a perfect and inexpensive way to do so. In many cases, however, it's possible to save a file in Inkscape into a format that the supplied software supplied is able to import and
convert. Here is a post on how to apply adhesive vinyl to ornaments and includes tips and tricks as well. 41. Harry Potter Bookmarks This next project is perfect for all those avid Harry Potter lovers to use while reading the series. You can also rotate the letters a bit by clicking on a selected letter to change the corner grab handles to double-headed
arrows that can be dragged to rotate the letter. Here is a cute craft to use as treat boxes that you can fill up with candy or party favors. 79. When the letters are positioned the way you want them, make sure the Select tool is active. Felt Bows and DIY Gift Bag This project is a cute addition for a card or placemat. Oh, and did I mention, a FREE SVG is
included. 4. Saving your file as an SVG is the default action. Unicorn Paper Clips This is one of the easiest but super cute projects yet. This tutorial can help you learn how to do so. 24. This post gives you access to a free SVG design and also provides tips on how to make clean cuts. It can even seamlessly shift between cutting a shape and writing a
note. It is both cool and pretty to look at. That’s the end of the list of free beginner Cricut projects. 15. Rolled Paper Flower How-to This step by step video tutorial gives you a pretty end result by just downloading the FREE SVG from the VIP library. It is how to make your own Easter Jars using paper and your Cricut machine. 46. BONUS, it does not
require any sewing! 49. Owl Valentine Gift Basket Here is a great and cute way to give a treat to your Valentine. These machines offer immense versatility to scrapbookers, greeting card makers, and to just about anyone who produces craft products from paper and cardstock. Game Day Gear This cute project shows you how to customize your own tshirt and create a sleeve or koozie for a hot drink in preparation for game day! 78. You can create your own gift box that I am sure she will love. 12. You can make this quick but easy DIY to hang in your kitchen. 37. Custom Coffee Mug Do you want your own custom coffee mug? Foil Quill Card This post shows you how to use a foil quill to make
simple but gorgeous designs. 69. In addition to producing your own files directly within the application, you can also import other vector file formats, including SVG and PDF, that have been produced in other software, such as Inkscape. You do need a Cricut Maker for this craft but it is such a fun and kid-friendly one to make. Open Inkscape. Easy
Card Making Tutorial With A Cricut Joy Do you have a Cricut Joy? Applying Vinyl to Ornaments Do you want to prepare for Christmas? Mother’s Day Gift Tag Here is another Mother’s Day craft that is used to write a quick message for your mom. Fabric Letters This craft is great for gifting or keeping it for your own children. You can download the
free SVG file from the VIP library and you’re all set. 28. It gives you all the nifty tips to learn how to work and cut with vinyl. 58. This gift basket can also be used for the fall if you customize the colours! 76. You may already be familiar with Sure Cuts A Lot, software that allows you to produce files in formats for a wide range of cutting machines.
Paper Butterfly Heart Canvas This next craft is a perfect example of a beginner Cricut project. This t-shirt craft if for you if you are! 68. All you need are some simple materials. 87. This is a great way to serve treats in. Unicorns are adorable and this craft is as well. Hexie Hand Towels This is a cute way to customize hand towels by creating hexies!
84. Leather Napkin Rings Looking for a nice addition to your table? Definitely save or pin this post to your Pinterest to check out all these great crafts. MASTER DESIGN SPACE! GET THE DESIGN SPACE CHEAT SHEETS FOR BEGINNERS! You can transfer these printable patterns to cardboard, cardstock, canvas, construction paper, fabric, felt,
foam, glass, leather, metal, notebook paper, paper, parchment paper, photo paper, plastic, plexiglass, poster board, rubber, steel, vinyl, wax paper, wrapping paper, wood, and many other types of materials. Not only are there a few different skills you’ll learn, but it is also such a pretty product to create. 56. You can now move the letters together so
they overlap and visually form a single unit. Here are some general tips for using Inkscape to make templates for use with various cutting machines. This is the craft for you. This cutting machine even includes cartridges to score materials. Grab the SVG from the VIP library and you are ready to go with minimal effort. 9. You can also add add text and
hearts to your image. IKEA Craft Room Drawer Hack Maybe you’re looking to up your craft room game. Custom Chipboard Puzzle Have you ever wanted to make a custom puzzle? Disney Parks are known for their awesome and tasty snacks and now you can rave about them on your t-shirt. This pro-level machine can cut 300+ materials including
leather, felt, paper, vinyl, matboard, balsa wood, and fabric with effortless precision. Designs you want to be cut must be paths. The Cricut Explore can cut 100 different materials include paper, cork, and bonded fabric. Your new design or pattern can be printed or downloaded in PNG, JPG, PDF, or SVG (Scalable Vector Graphics) format. Teacher’s
Koozie Here is another gift for teachers. You do need a Cricut Maker, but it is definitely a craft to do if you have one. 50. You can also use this tutorial if you do not have a Cricut. 40. This tutorial goes over a lot of the basics of working with adhesive vinyl by making your own custom labels. 22. That's all there is to it, although you'll no longer be able
to edit the text so check it for spelling mistakes and typos first. If you stayed till the end, thanks for checking out all these amazing and easy free Cricut Maker projects. This post shows you how to make an easy, two-toned card with the pre-made card packs available from Cricut. 18. DIY Easter Egg Labels This craft customizes Easter eggs to add a
bit of flare to your Easter party. 91. Fabric Paint Pillows This project can be altered according to your own design in order to cut out a stencil and use fabric paint to paint your own pillow. 89. DIY Farmhouse Sign Here is another simple farmhouse sign that is pretty to hang up around or outside of your home. 90. Furthermore, you can even use the
washable fabric pen to mark your patterns. The Cricut die-cutting machine simplifies sewing projects allowing you to cut cotton, denim, fleece, and more. Easy Farmhouse Sign This project shows you how to make a simple farmhouse sign with inexpensive materials. 85. Well this one is for you. DIY Autumn Pumpkin Cart Looking for an Autumn
related craft? This project takes approximately 5 minutes or less and is Christmas related. You also get some great tips on how to work with felt in this post. 8. Mermaid Pillow Is your child into mermaids? Fabric Letter Pillow This is another craft to make with your Cricut Maker, but it is quite easy to do. This gift tag is not only cute but I’m sure your
mother will appreciate it! 74. The software's documentation should include information on compatible file types. Users are able to produce professional results easily by automating the cutting process, cutting out designs that would be too complex to achieve by hand. Hold down the Shift key and just click unselected letters if any letters aren't
selected. Now go to Path > Union and the letters will be converted into a single path. It comes with a free SVG file available by accessing the VIP library. 30. DIY Grinch Glass This is a great way of getting into the Christmas spirit. 88. DIY Vinyl Sprinkles Now back to Halloween and Fall posts. Custom Cake Topper Would you like to make a custom
cake topper? DIY Food Pun Cards Do you have an occasion coming up that you want to celebrate with a little bit of fun? Now you can sleep in style with this cute unicorn sleep mask. View other cutting machines. Many are proprietary formats used by specific machine manufacturers. Easy Wedding Card This intricate card is the perfect addition to a
wedding gift. Mother’s Day Gift Box Maybe you have a pair of earrings or a small but special gift for your mom. Not only do you get a step by step video tutorial in this craft, but it is also a great piece of home decor for fall. 6. Plus, you receive the cut file! 81. This is a perfect Cricut Maker project. It’s a great gift to give a mother. 99. This post shows
you how to make a paper pansy, which can easily be turned into a wreath by making multiples of the pansy. 34. Valentine’s Day Treat Boxes Would you like to do something special for Valentine’s Day? Of course, you can use your magnets for your own crafts! 66. If you want to cut overlapping letters, you can do that without combining the letters into
a single path. Custom Intricate Wedding Invitations Looking for a beautiful way to create a custom wedding invite? This craft is adorable and definitely a keeper! 47. You also receive tips on how to make intricate cuts with your Cricut machine. 10. Paper Plate Fox Craft For Kids If you’re looking for an easy craft for children, this is it. Learn about the
Cricut cutting machines and find 1000’s of FREE patterns, designs, and SVG Cutting files. This machine offers the widest range of tools for cutting, writing, and adding decorative effects. The easy way to ensure this is to go to Edit > Select All, then Path > Object to Path. Iron-on Canvas Sprinkle Shoes This is a great hack to customizing canvas
shoes! 93. Your very own koozie or drink holder. 83.
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